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LESSON 1 -  
SCHEDULING WITH THE CALENDAR  

In this lesson, you will learn how to: 

·  Use the Calendar pane  

·  Navigate the Calendar  

·  Schedule a new appointment  

·  Schedule an event  

·  Work with the TaskPad  

·  Edit Calendar items  

·  Use Calendar views  

·  Edit Calendar color labels  

·  Apply automatic Calendar coloring  

·  Set a Calendar item as recurring  

·  Move Calendar items  

·  View side by side calendars  

·  Print Calendar information  

·  Delete Calendar items  
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USING THE CALENDAR PANE 

�  Discussion 

You can enter and track appointments, meetings, and tasks using the Microsoft 
Outlook Calendar component. You can use Calendar in conjunction with other 
components of Outlook to help manage all of your information. Calendar items are 
saved in the Calendar folder, which you can access through the Calendar pane. You 
can open the Calendar pane from the Navigation Pane or the Go menu. 
 
The Calendar pane opens to display the Date Navigator, a small monthly calendar at 
the top of the Navigation Pane, and the current calendar view in the right pane. The 
default calendar view is the Day view, which displays time slots for the current date. 
The time slots can be used for scheduling appointments and meetings. The buttons on 
the toolbar can be used to change the calendar view. 
 
The Date Navigator above the Navigation Pane displays calendar months in traditional 
calendar format with the current date outlined in red. You can use the Date Navigator 
to display other days, months and years. Depending on your screen resolution and the 
width of the Navigation Pane, the Date Navigator may display one, two, or more small 
calendar months. 

 
The Calendar pane 
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�  
The Reading Pane does not appear in the Calendar pane, but 
can be turned on. When it appears, it displays the details of the 
currently selected appointment. You may need to resize the 
Reading Pane to view all the appointment details. 

  

�  
The My Calendar pane displays your Calendar folder and 
any additional folders containing calendar items. While you 
can use the Folder List to open the Calendar folder, the My 
Calendars pane does not appear when you use this method. 

  
 

�  Procedures 

1. Click the Calendar button on the Navigation Pane. 

 

�  Step-by-Step 

Open the Calendar pane to view the Calendar folder. 
 

Steps Practice Data 

1. Click the Calendar button on the 
Navigation Pane. 
The Calendar pane opens displaying 
the Calendar folder. 

Click  Calendar 

 

NAVIGATING THE CALENDAR 

�  Discussion 

You can use the Date Navigator to create and view appointments for other dates in the 
Calendar. The Date Navigator may display one, two, four, or more months depending 
on your screen resolution and the width and height of the Navigation Pane. As you 
select days, weeks, or months in the Date Navigator, the scheduling area changes to 
display appointments for the selected dates. You can also view appointments in the 
scheduling area for multiple consecutive or non-consecutive dates. 
 
The default calendar view is the Day/Week/Month view, with the Day view selected. 
Other view options available from the buttons on the Standard toolbar include Work  
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Week, Week, or Month view. You can use Date Navigator or the Today button to 
display the current date. 

 
Navigating the Calendar 

 

�  Procedures 

1. Open the Calendar folder. 

2. To view the appointments for a specific date, click the date in the 
Date Navigator. 

3. To view the appointments for a consecutive range of dates, drag the 
range of dates in the Date Navigator. 

4. To view the appointments for a non-consecutive range of dates, 
select the first date you want to display in the Date Navigator. 

5. Hold [Ctrl]  and click the additional dates you want to display. 

6. To return the display to show only the appointments for one date, 
click the desired date in the Date Navigator. 

7. To scroll to another month, click the left or right scroll arrows at the 
top of the Date Navigator. 

8. To change the month in the Date Navigator, click and hold the name 
of the month currently displayed in the Date Navigator and drag to 
select the desired month. 
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9. To quickly go to the current date, select the Today button on the 
Standard toolbar. 

10. To change the way appointments appear in the scheduling area, 
select the Day, the Work  Week, the Week, or the Month button on 
the Standard toolbar. 

 

�  Step-by-Step 

Navigate the Calendar. 
 
If necessary, open the Calendar pane. 

 

Steps Practice Data 

1. To view the appointments for a 
specific date, click the date in the Date 
Navigator. 
The date changes at the top of the 
scheduling area and the appointments 
for the date appear. 

Click tomorrow’s date in 
the Date Navigator 

2. To view the appointments for a 
consecutive range of dates, drag the 
range of dates in the Date Navigator. 
The appointments for the selected 
range of dates appear in the 
scheduling area. 

Drag from Monday to 
Friday of this week in the 
Date Navigator 

3. To view the appointments for a non-
consecutive range of dates, select the 
first date you want to display in the 
Date Navigator. 
The first date is selected in the Date 
Navigator and the appointments for 
that date appear in the scheduling 
area. 

Click the first Wednesday 
of the current month 

4. Hold [Ctrl]  and click the additional 
dates you want to display. 
The appointments for all the selected 
dates appear in the scheduling area. 

Hold [Ctrl]  and click the 
second Wednesday of the 
current month 

5. To return the display to show only the 
appointments for one date, click the 
desired date in the Date Navigator. 
The appointments for the one date 
appear in the scheduling area. 

Click today’s date 
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Steps Practice Data 

6. To scroll to another month, click the 
left or right scroll arrows at the top of 
the Date Navigator. 
The selected month appears in the 
Date Navigator. 

Click  next to the month 
name in the Date 
Navigator 

7. To change the month in the Date 
Navigator, click and hold the name of 
the month currently displayed in the 
Date Navigator and drag to select the 
desired month. 
The selected month appears in the 
Date Navigator. 

Click and hold the name 
of a month in the Date 
Navigator and drag to 
select the previous month 

8. To quickly go to the current date, 
select the Today button on the 
Standard toolbar. 
The appointments for the current date 
appear in the scheduling area. 

Click Today 

9. To change the way appointments 
appear in the scheduling area, select 
the Day, Work  Week, Week, or 
Month button on the Standard 
toolbar. 
The appointment display in the 
scheduling area changes accordingly. 

Click  Month 

 
Practice the Concept: Drag the vertical border between the Navigation Pane and the 
scheduling area as far to the right as possible to display several columns of months in 
the Date Navigator. Return the width of the Navigation Pane to display only one 
column of months in the Date Navigator. Click the Day button to return the Calendar 
to the day format. 

SCHEDULING A NEW APPOINTMENT 

�  Discussion 

You can use the Calendar to schedule your appointments. Appointments are activities 
that do not involve notifying other people or scheduling resources. 
 
You schedule appointments in the Appointment window. This window allows you to 
enter a subject, location, and start and end times for an appointment, as well as make 
the appointment an all day event. If the new appointment conflicts with another 
appointment, a message appears above the subject, indicating a conflict. 
 



Outlook 2003 - Lvl 1 Lesson 1 - Scheduling with the  Calendar 

Cuesta College - Computer Services Page 7 
 

You can also attach reminders to appointments and indicate the amount of time before 
the appointment the reminder will activate. With this option, you can also choose a 
reminder sound for the alarm that occurs when the reminder activates. You must, 
however, have sound capabilities to hear the alarm. When you set a reminder, the 
Reminder window will pop-up while you are working in any software, as long as 
Outlook is open. 
 
You can schedule individual appointments in half-hour time slots or block an entire 
series of consecutive time slots. Time slots can be color coded to indicate their use. 
These color coded labels can be customized; standard labels include Important , Must 
Attend, and Personal. When you close the Appointment window, the appointment 
automatically appears in the time slot with the information entered in the window. 
 
If you are working in a network environment, you can access other users’ calendars 
and allow them to access yours. This option allows you and your co-workers to view 
one another’s available time slots, which is a useful feature when you are planning 
meetings and events. When scheduling an appointment, you can specify how the time 
slot you have allocated for your appointment appears to other users. Options include 
Free, Tentative, Busy, or Out of Office. 
 
When you are working with the Calendar, you will need to enter dates and times for 
appointments, meetings, and tasks. Outlook’s AutoDate tool simplifies the entry of 
this information. You can enter a description of a date or time in words, rather than in 
numbers. Outlook automatically converts the description to a number format for you. 
For example, if you enter the phrase one week from today in a date field, Outlook 
converts the phrase and automatically displays the numbers that represent the correct 
month, day, and year. The following table provides some examples of phrases 
recognized by AutoDate: 

 
July twenty-third  noon for, from, that, this, till, 

through, until 

March 28th midnight Christmas 

first of September nine o'clock am Christmas Eve 

this Fri five twenty p.m. Halloween 

2 days from now now Independence Day 

60 days after yesterday, today, 
tomorrow 

New Year's Day 

3 wks ago next, last New Year's Eve 

next week ago, before, beforehand, 
beginning, previous, 
start 

Veterans Day 
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The Appointment window 

 
  

�  
If you are viewing another folder, such as a mail folder, you 
can create a new appointment by selecting the File menu, 
pointing to the New command, and then selecting the 
Appointment command. 

  

�  
You can also use the Importance: High or Importance: Low 
buttons on the Standard toolbar in the Appointment window 
to set an importance level for the appointment. 

  

�  
You can also create an appointment by typing the subject 
directly into a time slot on the Calendar. After entering the 
subject, you can double-click the appointment to open the 
Appointment window and fill in the details. Double-clicking 
an empty time slot also opens the Appointment window. 

  
 

�  Procedures 

1. Open the Calendar folder. 

2. Select the date for the appointment you want to schedule in the Date 
Navigator. 

3. Drag the half-hour time slots you want to allocate for the 
appointment in the scheduling area. 

4. Click the  New Appointment button on the Standard toolbar. 

5. Type a subject for the appointment. 
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6. Select the Location box. 

7. Type a location for the appointment. 

8. Select the Label list. 

9. Select the label option you want to appear in the appointment’s 
selected time slot when viewed by others. 

10. Select the Reminder list. 

11. Select the desired time the alarm should warn you in advance of the 
appointment. 

12. Select the Show time as list. 

13. Select the option you want to appear in the appointment’s selected 
time slot when viewed by other users. 

14. Select the details box. 

15. Type details about the appointment. 

16. Select the Save and Close button. 

 

�  Step-by-Step 

Schedule a new appointment. 
 
If necessary, open the Calendar pane. 

 

Steps Practice Data 

1. Select the date for the appointment 
you want to schedule in the Date 
Navigator. 
The date changes at the top of the 
scheduling area and the appointments 
for the date appear. 

Click the next business 
day in the Date Navigator 

2. Drag the half-hour time slots you want 
to allocate for the appointment in the 
scheduling area. 
The time slots are selected in the 
scheduling area. 

Drag from 9:00 am to 
11:00 am 

3. Click the New Appointment button 
on the Standard toolbar. 
The Appointment window opens with 
the start and end times completed and 
the insertion point in the Subject box. 

Click  New 
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Steps Practice Data 

4. Type a subject for the appointment. 
The subject appears in the Subject 
box. 

Type Research for Global 
Proposal 

5. Select the Location box. 
The insertion point appears in the 
Location box. 

Press [Tab]  

6. Type a location for the appointment. 
The text appears in the Location box. 

Type Library 

7. Select the Label list. 
A list of labels appears. 

Click Label  

8. Select the label option you want to 
appear in the appointment’s selected 
time slot when viewed by others. 
The appropriate option is selected.  

Click Needs Preparation 

9. Select the Reminder list. 
A list of reminder times appears. 

Click Reminder  

10. Select the desired time the alarm 
should warn you in advance of the 
appointment. 
The time is selected. 

Click 30 minutes 

11. Select the Show time as list. 
The Show time as list appears. 

Click Show time as  

12. Select the option you want to appear in 
the appointment’s selected time slot 
when viewed by other users. 
The appropriate option is selected. 

Click Tentative  

13. Select the details box. 
The insertion point appears in the 
details box of the Appointment 
window. 

Press [Tab]  

14. Type details about the appointment. 
The text appears in the details box of 
the Appointment window. 

Type Review RFP and 
draft a rough outline for 
the development team. 

15. Select the Save and Close button. 
The Appointment window closes, the 
new appointment is saved, and both 
the subject and location of the 
appointment appear in the designated 
time slot in the scheduling area. 

Click  Save and Close 
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Practice the Concept: Double-click the 8:00 am time slot to open the Appointment 
window (you will select the date later). The subject of the appointment is Expo Booth 
Review and the location is the Board Room. 
 
Set the date by selecting the text in the Start time box, typing 2 weeks and pressing 
the [Enter]  key. Schedule the appointment from 8:00 AM to 10:00 AM. Set a 
reminder for one day before (scroll the Reminder list) and show the time as Busy, if 
necessary. Mark the appointment as Private (lower right corner) and use the 
Importance: High button (red exclamation mark) on the toolbar to set the importance 
level. Save and close the appointment.  
 
Display tomorrow’s schedule. Select the 12pm to 1:00 time slot, type Lunch meeting 
and press [Enter] . Double-click the Lunch meeting appointment to open the 
Appointment window. Enter the location Matt’s office and save and close the 
appointment. 
 
View the appointments in Month view. Then switch to Day view and display the 
current date. 

SCHEDULING AN EVENT 

�  Discussion 

You can use the Calendar to schedule events and annual events. An event is any 
activity that lasts one day or more. Examples of events include activities such as trade 
shows, vacations, and multi-day seminars. An annual event is any activity that lasts 
one day or more and occurs yearly on a specific date. An example of an annual event 
would include a birthday, holiday, or anniversary. To make an event an annual event, 
you must set its recurrence schedule. 
 
Scheduled events and annual events do not appear as blocks of time in the scheduling 
area. Instead, they appear as banners that span the top of the date or dates of the event. 
When other users view your schedule, events appear as free time. 
 
By default, events are scheduled as occupying an entire day. If you have an event that 
occupies only a portion of a day, you can deselect the All day event option in the 
Event window. When this option is deselected, boxes appear in which you can enter 
start and end times. Conversely, selecting the All day event option in an Appointment 
window changes the appointment to an event. 
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Scheduling an event 

 

�  Procedures 

1. Open the Calendar folder. 

2. Select the Actions menu. 

3. Select the New All Day Event command. 

4. Type a subject for the event. 

5. Select the Location box. 

6. Type a location for the event. 

7. Select the Start time box. 

8. Select the Start time list and select a start date, or type a start date 
for the event. 

9. Select the End time box. 

10. Select the End time list and select an end date, or type an end date 
for the event. 

11. Deselect the Reminder option, if desired. 

12. Select the Show time as list. 

13. Select the option that you want to appear in the appointment’s 
selected time slot when viewed by other users. 

14. Select the details area. 

15. Type details about the event. 



Outlook 2003 - Lvl 1 Lesson 1 - Scheduling with the  Calendar 

Cuesta College - Computer Services Page 13 
 

16. Select the Save and Close button. 

 

�  Step-by-Step 

Schedule an event. 
 
If necessary, open the Calendar pane and display the schedule for the current day. 

 

Steps Practice Data 

1. Select the Actions menu. 
The Actions menu appears. 

Click Actions 

2. Select the New All Day Event 
command. 
The Event window opens with the 
insertion point in the Subject box. 

Click New All Day Event 

3. Type a subject for the event. 
The subject appears in the Subject 
box. 

Type Sales Workshop 

4. Select the Location box. 
The insertion point appears in the 
Location box. 

Press [Tab]  

5. Type a location for the event. 
The text appears in the Location box. 

Type Global Knowledge 
Training Center 

6. Select the Start time box. 
The text in the Start time box is 
selected. 

Press [Tab]  twice 

7. Select the Start time list and select a 
start date, or type a start date for the 
event. 
The start date appears in the Start 
time box. 

Type next wed 

8. Select the End time box. 
The text in the End time box is 
selected. 

Press [Tab]  

9. Select the End time list and select an 
end date, or type an end date for the 
event. 
The end date appears in the End time 
box. 

Type next fri 
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Steps Practice Data 

10. Deselect the Reminder option, if 
desired. 
The Reminder option is deselected. 

Click  Reminder to 
deselect it 

11. Select the Show time as list. 
The Show time as list appears. 

Click Show time as  

12. Select the option that you want to 
appear in the appointment’s selected 
time slot when viewed by other users. 
The appropriate option is selected. 

Click Out of Office  

13. Select the details area. 
The insertion point appears in the 
details box in the Event window. 

Press [Tab]  

14. Type details about the event. 
The text appears in the details box. 

Type Team Leader 
seminar. 

15. Select the Save and Close button. 
The Event window closes, the event is 
saved, and both the subject and 
location of the event appear in the 
designated time slot on the Calendar. 

Click  Save and Close 

 
Click the Month button to view the event. If the event is scheduled for the next 
month, scroll down to view the month. Click the Day button to return to the default 
view. 
 
Practice the Concept: Create another all day event for the last Friday of the 
following month. The event is an Executive Retreat to be held at the Pine Valley 
Resort. Assign a label of Business, do not set a reminder for the event, and mark the 
time as Out of Office. Save and close the event. 

WORKING WITH THE TASKPAD 

�  Discussion 

In addition to scheduling appointments, you can also create and track tasks in the 
Outlook Calendar by displaying the TaskPad. Tasks can include personal errands, 
activities, or reminders and the TaskPad is similar to a “to do” list. 
 
While Outlook provides a separate Tasks component, it is often useful to view and 
create your tasks from the Calendar pane since tasks are often date dependent. The 
TaskPad works in conjunction with the Tasks component. When the TaskPad is 
enabled in the Calendar, it appears in a pane to the right of the calendar view, and the 
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Date Navigator moves from the top of the Navigation Pane to the top of the TaskPad 
pane. The TaskPad appears for all calendar views in the Day/Week/Month view. 
 
You can manually add a task to the TaskPad by entering a simple task description or 
by opening the Task window, which is similar to the Appointment window, to enter 
details about a task. 
 
Items in the TaskPad can be sorted by clicking the Icon, Complete or Subject column 
heading to sort the items in either ascending or descending order. You can also right-
click a column heading in the TaskPad and use the Arrange By submenu to arrange 
tasks using other criteria. 

 
Using the TaskPad 

 
  

�  
When you complete a task, you can mark it complete on the 
TaskPad by clicking the empty check box next to the task. A 
line then appears through the task. You can also mark a task 
complete on the Outlook Today page. 

  

�  
You can filter date-dependent items on the TaskPad by 
selecting the View menu, the TaskPad View command, and 
selecting the desired filter. 

  
 

  

�  
Tasks without due dates will not appear on the TaskPad if the 
Include Tasks With No Due Date option is disabled. This 
option can be accessed by selecting the View menu, pointing 
to the TaskPad View command, and then selecting the 
Include Tasks With No Due Date command. 
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�  Procedures 

1. Open the Calendar folder. 

2. Select the View menu. 

3. Select the TaskPad command. 

4. To create a task, click in the box at the top of the TaskPad on the text 
Click here to add a new Task. 

5. Type the text describing the new task. 

6. Press [Enter] . 

 

�  Step-by-Step 

Using the TaskPad. 
 
If necessary, open the Calendar pane. 

 

Steps Practice Data 

1. Select the View menu. 
The View menu appears. 

Click View 

2. Select the TaskPad command. 
The TaskPad opens in the right pane 
with the Date Navigator at the top. 

Click TaskPad 

3. To create a task, click in the box at the 
top of the TaskPad on the text Click 
here to add a new Task. 
The insertion point appears in the box, 
the text disappears, and a check box 
appears to the left of the box. 

Click in the first line of 
the TaskPad on the text 
Click here to add a new 
Task 

4. Type the text describing the new task. 
The text appears in the line. 

Type Call contract writers 

5. Press [Enter] . 
The task is entered into the TaskPad. 

Press [Enter]  
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Practice the Concept: Add the task Review budget to the TaskPad. Right-click the 
TaskPad column heading to display the shortcut menu. Use the Arrange By menu to 
sort the tasks by Conversation. Then return the task arrangement to Subject. 
 
Close the TaskPad by deselecting the command from the View menu. 

EDITING CALENDAR ITEMS 

�  Discussion 

You can edit any item in the Calendar, including appointments, events, meetings, and 
tasks. You can change the subject of the item, which appears in the Calendar, or you 
can open the item’s window and change any of its details. If all the options do not 
appear in the item’s window, you can resize the window as necessary. 
 

�  Procedures 

1. Open the Calendar folder. 

2. To edit an item’s subject, click once on the item. 

3. Edit the subject as desired. 

4. Press [Enter] . 

5. To edit an item’s details, double-click the item. 

6. Make changes as desired. 

7. Select the Save and Close button. 

 

�  Step-by-Step 

Edit calendar items. 
 
If necessary, open the Calendar pane. 
 
Display the appointments for the next business day in Day view. 
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Steps Practice Data 

1. To edit an item’s subject, click once 
on the item. 
The insertion point appears in the 
item. 

Click the Research for 
Global Proposal 
appointment 

2. Edit the subject as desired. 
The edited text appears in the item. 

Follow the instructions 
shown below the table 
before continuing on to 
the next step 

3. Press [Enter] . 
The edited text is saved in the item. 

Press [Enter]  

4. To edit an item’s details, double-click 
the item. 
The item’s window opens. 

Double-click the 
Research for New Global 
Proposal appointment 

5. Make changes as desired. 
The changes appear in the item’s 
window. 

Click  Reminder to 
deselect it 

6. Select the Save and Close button. 
The item’s window closes and the 
changes to the item are saved. 

Click  Save and Close 

 
Click to the left of the G in Global, type New and press the [Spacebar]. 
 
Return to the table and continue on to the next step (step 3). 

USING CALENDAR VIEWS 

�  Discussion 

The Day/Week/Month view is the default view for the Calendar, but you can display 
calendar items in several views. Additional calendar views are available on the 
Current View  submenu. If you frequently change views, you can display the calendar 
views on the Navigation Pane. 
 
Most calendar views apply a filter and display only the calendar items that meet the 
view criteria, such as displaying active or recurring appointments only. When you 
filter your Calendar, the appointments appear in a table view with the appointment 
information displayed in columns. You can then use the Arrange By menu to arrange 
the calendar items in a different order, such as by importance level. 
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�  
When you select a table view, the messages are grouped. You 
can remove the groupings by selecting the View menu, the 
Arrange By command, and deselecting the Show in Groups 
command. 

  
 

�  Procedures 

1. Open the Calendar folder. 

2. Select the View menu. 

3. Point to the Arrange By command. 

4. Point to the Current View  command. 

5. Select the desired table view. 

6. To arrange calendar items displayed in a table view, select the View 
menu. 

7. Point to the Arrange By command. 

8. Select the desired arrangement option. 

 

�  Step-by-Step 

Use calendar views. 
 
If necessary, display the Calendar pane. You should have a few appointments in your 
calendar. 

 

Steps Practice Data 

1. Select the View menu. 
The View menu appears. 

Click View 

2. Point to the Arrange By command. 
The Arrange By submenu appears. 

Point to Arrange By 

3. Point to the Current View  command. 
The Current View submenu appears. 

Point to Current View 

4. Select the desired table view. 
The calendar items appear in a table. 

Click Active 
Appointments 
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Steps Practice Data 

5. To arrange calendar items displayed in 
a table view, select the View menu. 
The View menu appears. 

Click View 

6. Point to the Arrange By command. 
The Arrange By submenu appears. 

Point to Arrange By 

7. Select the desired arrangement option. 
The calendar items are arranged by 
the selected option. 

Click Importance 

 
Use the Current View  menu to display the Day/Week/Month view. 

EDITING CALENDAR COLOR LABELS 

�  Discussion 

Appointments and meetings can be color coded to help you categorize and identify 
them. When you select a label for a calendar item, a color is automatically applied to 
the item. Each color comes with a label already assigned to it; labels include 
Important , Business, Personal, Vacation, Must Attend, plus many others. You can 
change the text assigned to each color. For example, you may want to change the label 
associated with the color blue from Business to Client Meeting. 
 
You can add color coded labels to an appointment or meeting using the Label list in 
the Appointment or Meeting window or use the Calendar Coloring button in the 
Calendar pane. Color coded appointments and meetings appear in your calendar with 
the selected color applied. Calendar colors only appear in a Day/Week/Month view. 
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Editing a Calendar color label 

 

�  Procedures 

1. Open the Calendar folder. 

2. Click the Calendar Coloring button  on the Standard toolbar. 

3. Select the Edit  Labels command. 

4. Select the label you want to change. 

5. Type the desired label text. 

6. Select OK. 

 

�  Step-by-Step 

Edit a Calendar color label. 
 
If necessary, open the Calendar pane. 

 

Steps Practice Data 

1. Click the Calendar Coloring button 
on the Standard toolbar. 
The Calendar Coloring menu appears. 

Click  
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Steps Practice Data 

2. Select the Edit  Labels command. 
The Edit Calendar Labels dialog box 
opens. 

Click Edit  Labels... 

3. Select the label you want to change. 
The label text is selected. 

Drag to select Travel 
Required 

4. Type the desired label text. 
The new label text appears. 

Type Expo Planning 

5. Select OK. 
The Edit Calendar Labels dialog box 
closes. 

Click OK 

 
Display the Calendar in Month view. Click the Expo Booth Review appointment and 
click the Calendar Coloring button. Assign the Expo Planning label to the 
appointment. Click in a blank area to deselect the appointment and view the applied 
color. 
 
Using the Date Navigator, display the first Tuesday of next month. Double-click any 
time slot to open the Appointment window. Create a new appointment with the 
subject Expo meeting. Enter a starting time of 2:00 PM. Use the Label list to apply 
the Expo Planning label to the appointment. Save and close the appointment. Notice 
the calendar color. 

 
Open the Edit Calendar Labels dialog box and change the Expo Planning label back 
to Travel Required. 

APPLYING AUTOMATIC CALENDAR COLORING 

�  Discussion 

Applying colors to appointments and meetings on your Calendar helps you categorize 
and identify them. You can color appointments and meetings manually, or you can set 
rules to automatically color items based on criteria. For example, you could set 
conditions that color items when a certain word is used in the subject or when a 
meeting request is sent by a specific person. 
 
Manual coloring always takes precedence over automatic coloring. If you have 
manually set a color, then automatic coloring will not be applied. Automatic coloring 
can be seen only by the person who set it up. If you open another person’s calendar, 
you will see the colors that were manually assigned, but not the automatic coloring. 
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Creating an automatic Calendar coloring rule 

 
  

�  
You can also open the Automatic Formatting dialog box by 
selecting the Edit  menu and the Automatic Formatting  
command. 

  
 

�  Procedures 

1. Open the Calendar folder. 

2. Select the Calendar Coloring button  on the Standard toolbar. 

3. Select the Automatic Formatting command. 

4. Select Add. 

5. Enter the name of the rule. 

6. Select Condition. 

7. Enter the desired condition(s). 

8. Select OK. 

9. Select the Label list. 

10. Select the label color for the condition. 

11. Select OK. 
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�  Step-by-Step 

Apply automatic colors to Calendar items. 
 
If necessary, open the Calendar pane. 

 

Steps Practice Data 

1. Select the Calendar Coloring button 
on the Standard toolbar. 
The Calendar Coloring list appears. 

Click  

2. Select the Automatic Formatting 
command. 
The Automatic Formatting dialog box 
opens. 

Click Automatic 
Formatting... 

3. Select Add. 
A new rule is added and the text in the 
Name box is selected. 

Click Add 

4. Type the name of the rule. 
The text appears in the Name box and 
in the Rules for this view list box. 

Type Training 

5. Select Condition. 
The Filter dialog box opens with the 
insertion point in the Search for 
word(s) box. 

Click Condition... 

6. Enter the desired condition(s). 
The condition(s) appear in the Filter 
dialog box. 

Follow the instructions 
shown below the table 
before continuing on to 
the next step 

7. Select OK. 
The Filter dialog box closes and the 
new condition is added. 

Click OK 

8. Select the Label list. 
A list of labels appears. 

Click Label  

9. Select a label color for the condition. 
The label color is selected. 

Click Important  

10. Select OK. 
The Automatic Formatting dialog box 
closes. 

Click OK 

 
In the Search for the word(s) box, type the text training;workshop . From the In list, 
select subject and notes fields. 
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Return to the table and continue on to the next step (step 7). 
 
Create a new appointment for next Monday from 1:00 - 3:00 PM. Enter the subject as 
Employee Training. Leave the Label as None. Save and close the appointment.  
 
Display the Calendar in Month view. Notice that the Employee Training 
appointment and the Sales Workshop event appear with a red label in the scheduling 
area. Open the Automatic Formatting dialog box and delete the Training  rule. 

SETTING A CALENDAR ITEM AS RECURRING 

�  Discussion 

You can set calendar items such as appointments, events, and meetings as recurring. 
Recurring items occur at the same time at regular intervals. For example, you may 
attend a staff meeting on the first Monday of every month. You can schedule that 
meeting as a recurring meeting so that it automatically appears on the proper days in 
the Calendar. 
 
When you set an item as recurring, you must indicate a recurrence pattern. The pattern 
can be Daily, Weekly, Monthly , or Yearly. Depending on which option you choose, 
other recurrence options will be available. For example, if an appointment will be 
repeated weekly, you can indicate on which weeks and days the item should be 
scheduled. If an event will be repeated monthly, you can specify on which days of the 
month the event should occur. You can also indicate when the item should be 
regenerated. Additionally, you can specify a range of recurrence, indicating a start 
date and, if necessary, an end date. 

 
The Appointment Recurrence dialog box 
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�  
You can create a new item as recurring by selecting the 
Actions menu and then the New Recurring Appointment or 
New Recurring Meeting command. 

  
 

�  Procedures 

1. Open the Calendar folder. 

2. Double-click the calendar item you want to set as recurring. 

3. Select the Actions menu. 

4. Select the Recurrence command. 

5. Select a Daily, Weekly, Monthly , or Yearly recurrence pattern 
option. 

6. Select additional recurrence pattern options, as desired. 

7. Select the Start list under Range of recurrence. 

8. Click the date when the recurrence should start. 

9. Select other options under Range of recurrence, as desired. 

10. Select OK. 

 

�  Step-by-Step 

Set a calendar item as recurring. 
 
If necessary, open the Calendar pane. 
 
Select next Monday’s date on the Date Navigator and notice that the Employee 
Training  appointment appears on this day. 

 

Steps Practice Data 

1. Double-click the calendar item you 
want to set as recurring. 
The item’s window opens. 

Double-click the 
Employee Training 
appointment 

2. Select the Actions menu. 
The Actions menu appears. 

Click Actions 
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Steps Practice Data 

3. Select the Recurrence command. 
The appropriate Recurrence dialog 
box opens. 

Click Recurrence... 

4. Select a Daily, Weekly, Monthly , or 
Yearly recurrence pattern option. 
The desired option is selected. 

Click  Weekly, if 
necessary 

5. Select additional recurrence pattern 
options, as desired. 
The desired options are selected. 

Follow the instructions 
shown below the table 
before continuing on to 
the next step 

6. Select other options under Range of 
recurrence, as desired. 
The desired options are selected. 

Click  No end date, if 
necessary 

7. Select OK. 
The Recurrence dialog box closes and 
the recurrence settings for the 
calendar item are saved. 

Click OK 

 
Enter 2 in the Recur every x week(s) on box. 
 
Return to the table and continue on to the next step (step 6). 
 
Select the Save and Close button in the Appointment window. Notice the recurrence 
symbol next to the appointment. Also notice that every other Monday is bolded in the 
Date Navigator. 

MOVING CALENDAR ITEMS 

�  Discussion 

You can move Calendar items to different time slots and dates. This function is 
helpful as it prevents you from having to delete an item and then re-enter the 
information. The easiest method for performing this task is to drag the item to the new 
time slot or date. 
 

  

�  
When you move an appointment or a meeting to a different 
date, it retains its original time slot. When you move a 
meeting, you are prompted to send out notification of the 
meeting change to all attendees and resources. 
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�  
You do not have to use the color bar to drag a calendar item to 
a new location as long as the insertion point does not appear in 
the subject text when you drag the item. 

  
 

�  Procedures 

1. Open the Calendar folder. 

2. To move an appointment or meeting to a new time slot on the same 
day, drag the color bar to the left of the item to the desired time slot. 

3. To move an appointment or meeting to a new date, drag the color bar 
to the left of the item to the desired date on the Date Navigator. 

 

�  Step-by-Step 

Move Calendar items. 
 
Display tomorrow’s date on the Date Navigator to view the Research for New 
Global Proposal appointment. 

 

Steps Practice Data 

1. To move an appointment or meeting to 
a new time slot on the same day, drag 
the color bar to the left of the item to 
the desired time slot. 
The item appears in the new time slot 
on the same day. 

Drag the color bar to the 
left of the Research for 
New Global Proposal 
appointment from the 9:00 
am time slot to the 3:30 
pm time slot 

2. To move an appointment or meeting to 
a new date, drag the color bar to the 
left of the item to the desired date on 
the Date Navigator. 
The item appears on the new date and 
the new date appears at the top of the 
scheduling area. 

Drag the color bar to the 
left of the Research for 
New Global Proposal 
appointment to the 
following business day on 
the Date Navigator 
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VIEWING SIDE BY SIDE CALENDARS 

�  Discussion 

Outlook allows you to create multiple Calendars to organize your appointments. You 
may want to create a separate calendar for personal appointments or a special project. 
All folders that contain calendar items appear in the My Calendars pane, regardless 
of where they are stored in the Folder List. Selecting the check box for a calendar 
opens the calendar in the Calendar pane. If more than one calendar is checked, the 
open calendars display side-by-side, with each calendar appearing in a different color. 
For example, you can view your calendar and a calendar shared by team members 
working on the same project as side-by-side calendars. 
 
You can change the view of side-by-side calendars, but all calendars change to display 
the same view. 

 
Viewing side by side calendars 

 
  

�  
You can change the background color of your primary 
calendar by selecting the Calendar Options button on the 
Preferences page in the Options dialog box. If desired, you 
can use the same color for all calendars. 

  

�  
When you open a shared calendar, Outlook adds the Other 
Calendars pane to the Navigation Pane. 
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�  
You can use the Share My Calendar link in the Navigation 
Pane to grant someone permission to share one of your 
calendars. The link opens the Permissions page. 

  
 

�  Procedures 

1. Open the Calendar folder. 

2. Select the check box of the calendars you want to open. 

3. Select the desired calendar view. 

4. Display the desired date period. 

 

�  Step-by-Step 

View side by side calendars. 
 
If necessary, open the Calendar pane. 
 
Create another calendar folder by selecting the File menu, pointing to the Folder 
command and selecting the New Folder command. Type Expo Calendar in the 
Name box. If necessary select Calendar Items from the Folder contains list and 
select Calendar from the Select where to place the folder list box. Select OK to 
create the folder. The Expo Calendar should appear in the My Calendars pane. 
 
Display next Monday’s date that contains appointments. 

 

Steps Practice Data 

1. Select the check box of the calendars 
you want to open. 
The calendar opens in the Calendar 
pane, next to the currently displayed 
calendars. 

Click  Expo Calendar 

2. Select the desired calendar view. 
The view is applied to all open 
calendars 

Select  Week 

3. Display the desired date period. 
Both calendars display the same date 
period. 

Drag the scroll bar down 
to display the last week of 
next month 
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Deselect the Expo Calendar in the My Calendars pane. Right-click the Expo 
Calendar and select the Delete “Expo Calendar” command. Select Yes to confirm 
the deletion. 

PRINTING CALENDAR INFORMATION 

�  Discussion 

You can print Calendar information and individual calendar items in a number of 
different ways. You can quickly print the details of an individual item such as a 
meeting or an appointment using the shortcut menu, or you can use the Print dialog 
box to print entire Calendar views. 
 
The Print dialog box offers control over the way your printed calendar output will 
appear. You can control the printer to be used, the style used in printing, the number 
of copies to be printed, and a number of other variables. You can also define a print 
range, which allows you to specify what date range of calendar items should be 
printed. 

 
Printing Calendar information 

 
  

�  
To quickly print the details of an individual calendar item, 
right-click the item and select the Print  command or click the 
Print  button on the Standard toolbar. 
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�  
You can preview printed output before it prints by clicking 
Preview in the Print dialog box. 

  
 

�  Procedures 

1. Open the Calendar folder. 

2. Select the File menu. 

3. Select the Print  command. 

4. Select print options as desired. 

5. Select OK. 

 

�  Step-by-Step 

Print Calendar information. 
 
If necessary, open the Calendar pane. 

 

Steps Practice Data 

1.  Select the File menu. 
The File menu appears. 

Click File 

2. Select the Print  command. 
The Print dialog box opens. 

Click Print…  

3. Select print options as desired. 
The desired options are selected. 

Scroll the Print style list 
box as necessary and click 
Monthly Style 

4. Select OK. 
The Print dialog box closes, a Printing 
message box opens to inform you of 
the print status, Outlook prints the 
Calendar information according to the 
options selected, and the message box 
closes. 

Click OK 

 
Practice the Concept: Select a day when you have and appointment and open the 
Print dialog box. Select the Tri-fold Style  and preview the output. Close the Print 
Preview window. 
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DELETING CALENDAR ITEMS 

�  Discussion 

You can delete appointments, events, and tasks in the Calendar simply by deleting the 
item. When you try to delete recurring items, however, you are prompted to delete 
either all future occurrences of the item or just the one selected occurrence. When you 
want to delete meetings, you are prompted to send a cancellation notice, which is 
created automatically, to all attendees of the meeting. 
 
In addition to using the Delete button on the Standard toolbar, you can delete 
Calendar entries using the Delete command on the shortcut or Edit  menu, or by 
pressing the [Delete] key. 
 

�  Procedures 

1. Open the Calendar folder. 

2. Select the item you want to delete. 

3. Click the Delete button  on the Standard toolbar. 

4. Select an option to complete the process, if necessary. 

5. Select OK, if necessary. 

 

�  Step-by-Step 

Delete Calendar items. 
 
If necessary, open the Calendar pane. 
 
Select next Monday’s date to view the first occurrence of the Employee Training 
appointment, which is a recurring appointment. 

 

Steps Practice Data 

1. Select the item you want to delete. 
The item is selected. 

Click the Employee 
Training  recurring 
appointment 
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Steps Practice Data 

2. Click the Delete button on the 
Standard toolbar. 
The item is deleted or, if the selected 
item is a recurring item or a meeting, 
a warning box opens, prompting you 
to select an option to complete the 
process. 

Click  

3. Select an option to complete the 
process, if necessary. 
The desired option is selected. 

Click  Delete the series. 

4. Select OK, if necessary. 
The warning box closes and the item is 
deleted. 

Click OK 

 
Practice the Concept: Change the Calendar view to Active Appointments. Select all 
the Calendar items and delete them. Change to the Day/Week/Month view. 
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EXERCISE 

SCHEDULING WITH THE CALENDAR 

�  Task 

Practice scheduling with the Calendar. 
 

1. Open the Calendar, if necessary. 

2. Display the appointments for next Thursday. Delete any items that 
are scheduled for that day, if necessary. 

3. Schedule an appointment. Use the 10:00 to 11:00 am time slot. For 
the subject, enter Interview for graphic artist position . For the 
location, enter My office. Use AutoDate to schedule the appointment 
for next Monday, instead of the currently displayed date. Accept the 
other default settings and save the appointment. 

4. Display the first Wednesday of next month and type an appointment 
into the 1:00 pm time slot with the subject Call Karl . 

5. Use the Date Navigator to display the last Friday of the current 
month. Schedule an event called Executive Retreat to be held in the 
Board Room. Disable the reminder, mark the time as Busy and give 
the event a category of Business. Save the event and close the Event 
window. 

6. Make the Executive Retreat event recurring. Schedule the event to 
occur on the last Friday of every month. Accept the other defaults 
and save the event. 

7. Display the TaskPad. 

8. Enter tasks called Call the Dentist and Backup computer. 

9. Hide the TaskPad. 

10. Switch the view to the Month view. 

11. Return to the Day view. 

12. Change the color label Birthday  to Executive Retreat. Open one of 
the Executive Retreat appointments and open the series. Apply the 
Executive Retreat label to the appointment. 
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13. Add an automatic formatting rule called Calls to color appointments 
with the words phone;call in the subject field. Apply the yellow 
Phone Call label to the rule. Display the first Wednesday of next 
month to see if the Call Karl  appointment was formatted. At 2:00 
pm on that day, add an appointment with the subject Phone Tina. 

14. Delete all occurrences of the Executive Retreat event. 

15. Move the Interview for graphic artist position appointment to the 
next business day. 

16. Add the text (Mktg Dept) at the end of the appointment subject. 

17. Display the day with the Interview for graphic artist position 
(Mktg Dept) appointment and print the daily view of the Calendar. 

18. Change the Executive Retreat color label to Birthday . Delete the 
Calls automatic formatting rule. 

19. Change the view to display all active appointments.  

20. Delete all the appointments.  

21. Switch to the Day/Week/Month view. 

 



 

 

LESSON 2 -  
MANAGING MEETINGS  

In this lesson, you will learn how to: 

·  Schedule a meeting  

·  Schedule a resource for a meeting  

·  Accept/Decline meeting requests  

·  Propose a new meeting time  

·  Respond to a new time proposal  

·  Track meeting responses  

·  Update a meeting  

·  Cancel a meeting  

·  Create group calendars  
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SCHEDULING A MEETING 

�  Discussion 

You can use the Outlook Calendar to schedule meetings. A meeting is an appointment 
to which you invite people and resources. Resources include objects that you may 
typically use in a meeting, such as a conference room, an overhead projector, or a 
laptop computer. Both people and resources may or may not be available for a 
meeting, but you can use Outlook to determine a time for your meeting that best fits 
all attendees’ and resources’ schedules. 
 
You can use the Plan a Meeting feature to create and send meeting requests and to 
reserve resources. This meeting planner allows you to invite all attendees and select a 
time for the meeting. You can enter the names of people and resources directly into 
the All Attendees list, or you can select names from an address book. The All 
Attendees list displays a list of every person and resource attending the meeting. The 
envelope that appears next to the name or resource indicates that a request will be sent 
to that attendee or resource. If you don’t want to send a meeting request to a particular 
attendee, click the envelope next to their name and select the Don’t send meeting to 
this attendee option. 
 
The planner displays the free and busy times of every attendee or resource invited to 
the meeting. If a time slot is blank, the attendee or resource is free. If a time slot is 
colored, then the attendee or resource is either busy or tentatively busy. You can right-
click any attendee’s or resource’s busy time slot in the planner for more information 
concerning that attendee’s or resource’s schedule. If a scheduling conflict occurs, the 
AutoPick tool can automatically locate free time slots for the specified invitees and 
resources. You can use AutoPick for all invitees, all people and one resource, required 
people only, or required people and one resource. Responses to the meeting requests 
are delivered to your Inbox and can be tracked in the Meeting window. 
 
Meeting times in the planner are indicated by the green and red vertical bars. The 
green bar indicates the meeting start time and the red bar indicates the meeting end 
time. You can move these bars to adjust the length of a meeting. The hours available 
in the Plan a Meeting dialog box are based on the Calendar working hours set in the 
Options dialog box. These hours may vary depending on your working environment. 
 
You can access the meeting planner directly from the Actions menu or from the 
Scheduling page in the Meeting window. 
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Using the Plan a Meeting dialog box 

 
  

�  
When adding people and resources from the Address Book, 
each entry you select can be designated as Required, 
Optional, or Resource. If you decide not to invite a potential 
attendee before sending the invitation, select the attendee’s 
name and press the [Delete] key. 

  

�  
You can also add attendees by typing their names or e-mail 
addresses into the All Attendees column. Attendees that you 
type in are automatically designated as Required. You can 
however, select the icon to the left of the name and select 
another option from the drop-down list.  

  

�  
You can create a new meeting request from any folder by 
selecting the File menu, pointing to the New command and 
selecting the Meeting Request command. After entering the 
invitees names in the To box and selecting a date and time for 
the meeting, you can use the Scheduling page to access the 
meeting planner. 

  
 

�  Procedures 

1. Open the Calendar folder. 

2. Select the Actions menu. 

3. Select the Plan a Meeting command. 

4. Select Add Others. 
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5. Select Add from Address Book. 

6. Add the attendees and resources to the meeting. 

7. Select OK. 

8. When a satisfactory time slot is located for all attendees and 
resources, select Make Meeting. 

9. Type a subject for the meeting. 

10. Select the Location box. 

11. Type a location for the meeting. 

12. Select options as desired and then select the Send button. 

13. Select Close. 

 

�  Step-by-Step 

Schedule a meeting. 
 
Open the Calendar pane and display the schedule for the current day. 
 
Pair up with a fellow student so that you can exchange meeting requests. Use the Date 
Navigator to select next Thursday on the Calendar. In the Day view, click the 
9:00 AM time slot. 
 
Note: In step 8, enter your initials after the Departmental Meeting subject (i.e., 
Departmental Meeting:TJ). 

 

Steps Practice Data 

1. Select the Actions menu. 
The Actions menu appears. 

Click Actions 

2. Select the Plan a Meeting command. 
The Plan a Meeting dialog box opens. 

Click Plan a Meeting... 

3. Select Add Others. 
The Add Others menu appears. 

Click Add Others  

4. Select Add from Address Book. 
The Select Attendees and Resources 
dialog box opens. 

Click Add from Address 
Book... 

5. Add the attendees and resources to the 
meeting. 
The attendee names and resources 
appear in the appropriate boxes. 

Follow the instructions 
shown below the table 
before continuing on to 
the next step 
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Steps Practice Data 

6. Select OK. 
The Select Attendees and Resources 
dialog box closes and the selected 
attendees and resources appear in the 
All Attendees list in the Plan a 
Meeting dialog box. 

Click OK 

7. Drag the red and/or green bar in the 
calendar box to adjust the length of the 
meeting. 
The length of the meeting is adjusted 
in the calendar box and the Meeting 
end time box. 

Drag the red and/or green 
bar so that the red bar 
starts at 10:30 am and the 
meeting is scheduled for 
1-1/2 hours (the green bar 
should start at 9:00 am) 

8. Select Options. 
The Options menu appears. 

Click Options  

9. Point to the AutoPick command to 
display a list of schedules to check. 
The AutoPick submenu appears. 

Point to AutoPick 

10. Select the desired command to indicate 
the schedules you want to check using 
AutoPick. 
The green and red bars in the calendar 
box move to display the next available 
time slot. 

Click All People and 
Resources, if necessary 

11. Continue to select the AutoPick 
button to display other free time slots, 
if desired. 
The red and green bars in the calendar 
box move to select the next available 
time slot and the new times appear in 
the Meeting start time and Meeting 
end time boxes. 

Click AutoPick Next >> 
twice 

12. When a satisfactory time slot is 
located for all attendees and resources, 
select Make Meeting. 
The Meeting window opens with the 
To box completed and the insertion 
point in the Subject box. 

Click Make Meeting 

13. Type a subject for the meeting. 
The text appears in the Subject box. 

Type Departmental 
Meeting:<your initials> 

14. Select the Location box. 
The insertion point appears in the 
Location box. 

Press [Tab]  
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Steps Practice Data 

15. Type a location for the meeting. 
The location appears in the Location 
box. 

Type Conference Room A 

16. Select options as desired and then 
select the Send button. 
The Meeting window closes and the 
meeting requests are sent to the 
attendees and resources. 

Click  Send 

 
Select the name of your partner and select Required. 
 
Return to the table and continue on to the next step (step 6). 
 
Close the Plan a Meeting dialog box and notice the meeting on your Calendar. 
 
Practice the Concept: You can also create a meeting request from another folder. 
Open the Mail  pane. Open the Meeting window by selecting the File menu, pointing 
to the New command and selecting the Meeting Request command. Enter your 
partner’s name or e-mail address into the To box and then display the Scheduling 
page. Notice that you can access the meeting planner by opening the Meeting window 
in any folder. Close the Meeting window without saving the changes. 

SCHEDULING A RESOURCE FOR A MEETING 

�  Discussion 

You can schedule a resource for a meeting just as you would schedule a person. 
Resources include conference rooms and equipment, such as a projector. In order to 
schedule a resource, it must be set up with its own mailbox, usually by the system 
administrator. 
 
The same scheduling rules that apply to a person apply to a resource. When 
scheduling a meeting, you invite the resource and, if the resource is free, it will accept 
the meeting. If the resource is not free, it will automatically reject the invitation. 
 

  

�  
In order to schedule a resource, it must be set up with its own 
mailbox, usually by the system administrator. The system 
administrator can restrict the ability to schedule a resource. 
For example, the administrator can decide that only a manager 
can schedule a particular resource. 

  

�  
Resources appear in the Location box on the Appointments 
page in the Meeting window as well as in the To box. 
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�  Procedures 

1. Open the Calendar folder. 

2. Select the Actions menu. 

3. Select the Plan a Meeting command. 

4. Select Add Others. 

5. Select Add from Address Book. 

6. Select the desired resource. 

7. Select Resources. 

8. Add any other attendees or resources to the meeting. 

9. Select OK. 

10. When a satisfactory time slot is located for all attendees and 
resources, select Make Meeting. 

11. Type a subject for the meeting. 

12. Select options as desired and then select the Send button. 

13. Select Close. 

 

�  Step-by-Step 

Schedule a resource for a meeting. 
 
Open the Calendar pane and display the schedule for the current day. 
 
Pair up with a fellow student so that you can exchange meeting requests. Use the Date 
Navigator to select next Wednesday on the Calendar. One partner should select the 
9:00 - 10:00 AM time slot, while the other partner selects the 1:00 - 2:00 PM time 
slot. 
 
Note: In step 10, enter your initials after the Proposal Prep Meeting subject (i.e., 
Proposal Prep Meeting:TJ). 

 

Steps Practice Data 

1. Select the Actions menu. 
The Actions menu appears. 

Click Actions 
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Steps Practice Data 

2. Select the Plan a Meeting command. 
The Plan a Meeting dialog box opens. 

Click Plan a Meeting... 

3. Select Add Others. 
The Add Others menu appears. 

Click Add Others  

4. Select Add from Address Book. 
The Select Attendees and Resources 
dialog box opens. 

Click Add from Address 
Book... 

5. Select the desired resource. 
The desired resource is selected. 

Scroll as necessary in the 
Name list box and click 
Conference Room1 or the 
resource as indicated by 
your instructor 

6. Select Resources. 
The resource is added to the Required 
list box. 

Click Resources -> 

7. Add any other attendees or resources 
to the meeting. 
The attendee names or resources 
appear in the appropriate box. 

Follow the instructions 
shown below the table 
before continuing on to 
the next step 

8. Select OK. 
The Select Attendees and Resources 
dialog box closes and the selected 
attendees and resources appear in the 
All Attendees list in the Plan a 
Meeting dialog box. 

Click OK 

9. When a satisfactory time slot is 
located for all attendees and resources, 
select Make Meeting. 
The Meeting window opens with the 
To box completed and the insertion 
point in the Subject box. 

Click Make Meeting 

10. Type a subject for the meeting. 
The text appears in the Subject box. 

Type Proposal Prep 
Meeting:<your initials> 

11. Select options as desired and then 
select the Send button. 
The Meeting window closes and the 
meeting requests are sent to the 
attendees and resources. 

Click  Send 

 
Select your partner’s name and select Required. Select Projector 1 (or another 
resource as indicated by your instructor) and add the resource to the Resources box. 
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Return to the table and continue on to the next step (step 8). 
 
Close the Plan a Meeting dialog box and notice the meeting on your Calendar. 

ACCEPTING/DECLINING MEETING REQUESTS 

�  Discussion 

As other users schedule meetings, you may receive meeting requests in your Inbox. 
You have the option of accepting, declining, or submitting a tentative response. You 
can respond to a meeting request from the Reading Pane or the Message window. 
When you select the Accept, Tentative, or Decline button, Outlook opens a warning 
box in which you have options to edit the response, send the response, or not send the 
response at all. 
 
Meeting requests are automatically added to your schedule as a tentative appointment 
when Outlook updates your Calendar or after you read the meeting request. If you 
accept the meeting, the meeting time changes to busy. If you decline the meeting, the 
meeting is removed from your schedule. 

 
Responding to a meeting request 

 
  

�  
Meeting responses are delivered to the meeting planner’s 
Inbox and are also tracked on the Tracking page in the 
original meeting request. 
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�  Procedures 

1. Open the Inbox folder. 

2. Select or open meeting request message. 

3. Select the Accept button, the Decline button, or the Tentative button 
as desired. 

4. Select the Send the response now. option. 

5. Select OK. 

 

�  Step-by-Step 

Accept/Decline meeting requests. 
 
If necessary, open the Calendar pane and display next Wednesday’s schedule. 
 
After your partner’s meeting request is delivered to your Inbox, your schedule should 
show a tentative meeting for that time slot. Open your Inbox folder. You should have 
received a Proposal Prep Meeting:<your partner’s initials> invitation in your Inbox. 
 
Select the Proposal Prep Meeting:<your partner’s initials> invitation in your Inbox 
folder, if necessary. 

 

Steps Practice Data 

1. Select the Accept, Tentative, or 
Decline button as desired. 
A Microsoft Outlook warning box 
opens, prompting you for a selection. 

Click  Accept 

2. Select the desired option. 
The desired option is selected. 

Click  Send the 
response now., if 
necessary 

3. Select OK. 
The Microsoft Outlook warning box 
closes and the response to the meeting 
is sent. 

Click OK 

 
You should receive an Accepted: Proposal Prep Meeting message in your Inbox. 
Select the message and view the message in the InfoBar. 
 
Display your Calendar for next Wednesday and notice that the meeting is no longer 
tentative. 
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PROPOSING A NEW MEETING TIME 

�  Discussion 

If you would like to respond to a new meeting by proposing a new time, you can use 
the Propose New Time button to select a new time and respond to the invitation to 
the meeting. You can propose a new time from the Reading Pane or the Message 
window. 
 
When you use the Propose New Time button, you should also use the AutoPick Next 
or Previous button to find a time that is open to all participants of the meeting. When 
using the Propose New Time button, the message is delivered with an InfoBar 
indicating that you have tentatively accepted this meeting, but would like to propose a 
new time. After you send the message, the meeting organizer receives a New Time 
Proposed message that he or she can respond to. 
 

  

�  
The default response when you are proposing a new time is 
Tentative. You can change the default to Accept or Decline 
by selecting the Tools menu, the Options command, and the 
Calendar Options button. Select the desired option from the 
Use this response when you propose new meeting times list. 

  
 

�  Procedures 

1. Open the Inbox folder. 

2. Select or open the meeting invitation message. 

3. Select the Propose New Time button in the Reading Pane or 
Meeting invitation window. 

4. Select a new time. 

5. Select the Propose Time button. 

6. Select the Send button. 

 

�  Step-by-Step 

Propose a new meeting time. 
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Open your Inbox folder. You should have received a Departmental Meeting:<your 
partner’s initials> invitation in your Inbox. 
 
Select the Departmental Meeting:<your partner’s initials> invitation in your Inbox 
folder. 

 

Steps Practice Data 

1. Select the Propose New Time button 
in the Reading Pane or Meeting 
invitation window. 
The Propose New Time dialog box 
opens. 

Click  Propose New 
Time at the top of the 
Reading Pane 

2. Select a new time. 
The red and green bars in the calendar 
box move to select the next available 
time slot and the new times appear in 
the Meeting start time and Meeting 
end time boxes. 

Follow the instructions 
shown below the table 
before continuing on to 
the next step 

3. Select the Propose Time button. 
The Propose New Time dialog box 
closes, and a new Message window 
opens with the list of recipients in the 
To box. 

Click Propose Time 

4. Select the Send button. 
The Message window closes, and the 
message with the proposed new time is 
sent. 

Click  Send 

 
One partner should click the AutoPick Next button while the other partner clicks the 
AutoPick Previous (<<) button. 
 
Return to the table and continue on to the next step (step 3). 
 
You should receive a message from your partner in your Inbox proposing a new 
meeting time. 

RESPONDING TO A NEW TIME PROPOSAL 

�  Discussion 

When you receive a New Time Proposed message from an invitee for a meeting you 
have scheduled, you can open it to view your options. If you invited several people to 
the meeting, you can use the View All Proposals button in the toolbar to view all new 
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proposed times. This button opens the Scheduling page in the Meeting window where 
you can view the current meeting time and all the new meeting proposal times. 
 
After checking the proposals for conflicts and selecting the best time for the meeting, 
you can select the Send Update button on the toolbar to send updated meeting 
requests to all the invitees. 

 
Responding to a new time proposal 

 

�  Procedures 

1. Open the Inbox folder. 

2. Double-click the New Time Proposed meeting response in your 
Inbox. 

3. Select the View All Proposals button on the Standard toolbar. 

4. Select the desired proposal in the Proposed Date and Time list at 
the top of the Scheduling page. 

5. Select the Send Update button. 

 

�  Step-by-Step 

Respond to a new time proposal. 
 
If necessary, open your Inbox folder. You should have received a New Time 
Proposed: Departmental Meeting:<your initials> meeting response. 
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Steps Practice Data 

1. Double-click the New Time Proposed 
meeting response in your Inbox. 
The message opens in a Meeting 
Response window. 

Double-click the New 
Time Proposed: 
Departmental 
Meeting:<your initials> 
message 

2. Select the View All Proposals button 
on the Standard toolbar. 
The Scheduling page of the Meeting 
window opens with the current 
meeting time in the Meeting Planner. 

Click  View All 
Proposals 

3. Select the desired proposal in the 
Proposed Date and Time list at the 
top of the Scheduling page. 
The new time appears in the Meeting 
Planner. 

Click the new time 
proposed by your partner 
(second row) 

4. Select the Send Update button. 
The Meeting window closes and the 
updates are sent. 

Click  Send Update 

 
You should receive an Updated: Departmental Meeting:<your partner’s initials> 
meeting response to your new proposed time in your Inbox. Accept the new meeting 
time and send the response. 

TRACKING MEETING RESPONSES 

�  Discussion 

When you schedule a meeting, you send messages to people requesting their presence. 
As the attendees receive these requests, they should respond to you by indicating 
whether or not they will attend. You can monitor these responses to track who will be 
attending and who has declined your meeting request, as well as which of the 
resources you invited will be available for use. The Tracking page in the Meeting 
window lists the people and resources that have been invited to the meeting and their 
responses. 
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Tracking meeting responses 

 

�  Procedures 

1. Open the Calendar folder. 

2. Double-click the meeting for which you want to check meeting 
responses. 

3. Select the Tracking tab. 

4. View the grid. 

5. Close the Meeting window. 

 

�  Step-by-Step 

Track responses to your meeting requests. 
 
Open the Calendar and select the following Thursday to display the date on which the 
Departmental Meeting:<your initials> entry appears. 

 

Steps Practice Data 

1. Double-click the meeting for which 
you want to check meeting responses. 
The Meeting window opens with the 
meeting details displayed. 

Double-click the 
Departmental 
Meeting:<your initials> 
meeting 
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Steps Practice Data 

2. Select the Tracking tab. 
The Tracking page appears with the 
meeting responses displayed. 

Click the Tracking tab 

 
View the grid and then close the Meeting window. 

UPDATING A MEETING 

�  Discussion 

When you update a meeting, you can change the attendees, time, location, and 
resources for any meeting for which you are the organizer. You cannot change 
information for meetings that you do not organize. 
 
You can change the status of a meeting to recurring; or, if a meeting attendee calls to 
decline a meeting invitation instead of responding via e-mail, you can also update the 
meeting and change the attendee’s status to declined. 
 

�  Procedures 

1. Open the Calendar folder. 

2. Open the meeting you want to update. 

3. Select the Actions menu. 

4. Select the Add or Remove Attendees command. 

5. Select a name from the Name list box. 

6. Select Required or Optional. 

7. Select OK. 

8. Select the Send Update button. 

9. Select the desired option. 

10. Select OK. 

 

�  Step-by-Step 

Update a meeting. 
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Open the Calendar to the Thursday containing the Departmental Meeting:<your 
name> meeting. Open the Departmental Meeting:<your name> meeting. 

 

Steps Practice Data 

1. Select the Actions menu. 
The Actions menu appears. 

Click Actions 

2. Select the Add or Remove Attendees 
command. 
The Select Attendees and Resources 
dialog box opens. 

Click Add or Remove 
Attendees... 

3. Select a name from the Name list box. 
A name is selected. 

Scroll as necessary and 
click the name of a fellow 
student from the Name list 
box as indicated by your 
instructor 

4. Select Required or Optional. 
The name is added to the Required or 
Optional list box. 

Click Optional -> 

5. Select OK. 
The Select Attendees and Resources 
dialog box closes. 

Click OK 

6. Select the Send Update button. 
The Send Update to Attendees warning 
box opens, prompting you to designate 
who should receive the message. 

Click  Send Update 

7. Select the desired option. 
The appropriate option is selected. 

Click  Send updates 
only to added or deleted 
attendees., if necessary 

8. Select OK. 
The Send Update to Attendees warning 
box and the Message window close 
and an update is sent to the 
appropriate attendees. 

Click OK 

 
Practice the Concept: Move the meeting to the following day at the same time. 
Select Yes to send an update to the meeting attendees. Send the update. 
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CANCELING A MEETING 

�  Discussion 

You can cancel a scheduled meeting. When you cancel a meeting that you have 
already created, and to which you have sent invitations, you should always send 
cancellation notices to the meeting attendees. 
 

  

�  
You can also cancel a meeting when it is open by clicking the 
Delete button in the Meeting window. 

  
 

�  Procedures 

1. Open the Calendar folder. 

2. Select the meeting you want to delete. 

3. Click the Delete button  on the Standard toolbar. 

4. Select the desired notification option. 

5. Select OK. 

6. Select the Send button, if necessary. 

 

�  Step-by-Step 

Cancel a meeting. 
 
Open the Calendar to the Wednesday containing the Proposal Prep Meeting:<your 
initials> meeting. 

 

Steps Practice Data 

1. Select the meeting you want to delete. 
The meeting is selected. 

Click the Proposal Prep 
Meeting:<your initials> 
meeting 
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Steps Practice Data 

2. Click the Delete button on the 
Standard toolbar. 
A Microsoft Outlook warning box 
opens, asking if you want to send a 
notification for the canceled meeting. 

Click  

3. Select the desired notification option. 
The appropriate notification option is 
selected. 

Click  Send 
cancellation and delete 
meeting., if necessary 

4. Select OK. 
The Microsoft Outlook warning box 
closes, and a new Meeting window 
opens. 

Click OK 

5. Select the Send button. 
The Meeting window closes, a 
cancellation message is sent to all 
attendees and resources, and the 
meeting is deleted from your 
Calendar. 

Click  Send 

 

CREATING GROUP CALENDARS 

�  Discussion 

Group calendars can be created for a particular group of people and/or resources. 
When you want to plan a meeting, you can open the group calendar, view the 
availability of everyone in the group at a single glance, and then schedule a meeting. 
 
You can create and save more than one group calendar. For example, you can create a 
calendar with all the employees from a particular department, or a calendar with a 
group of people that attend a specific meeting. Group calendars can also be created 
solely from resources. You may want to create a group calendar for resources to find 
when they are free. 
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Create a group calendar 

 
  

�  
In order for a resource to be included in a group calendar, it 
must be set up with its own mailbox by the system 
administrator. 

  

�  
You can also view other users’ free/busy information on other 
networks, the Internet, or an intranet. 

  

�  
You can also use the View Group Schedules button on the 
Standard toolbar in the Calendar pane to work with group 
schedules. 

  
 

�  Procedures 

1. Open the Calendar folder. 

2. Select the Actions menu. 

3. Select the View Group Schedules command. 

4. Select New. 

5. Type a name for the new group schedule. 

6. Select OK. 

7. Select the names of the people or resources you want to include in 
the group schedule. 

8. Select the Save and Close button. 
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�  Step-by-Step 

Create a group calendar. 
 
If necessary, open the Calendar pane. 

 

Steps Practice Data 

1. Select the Actions menu. 
The Actions menu appears. 

Click Actions 

2. Select the View Group Schedules 
command. 
The Group Schedules dialog box 
opens. 

Click View Group 
Schedules... 

3. Select New. 
The Group Schedules dialog box 
closes and the Create New Group 
Schedule dialog box opens with the 
insertion point in the Type a name for 
the new Group Schedule box. 

Click New... 

4. Type a name for the new group 
schedule. 
The name appears in the Type a name 
for the new Group Schedule box.  

Type Marketing Dept 

5. Select OK. 
The Create New Group Schedule 
dialog box closes and the group 
schedule dialog box opens. 

Click OK 

6. Select the names of the people or 
resources you want to include in the 
group schedule. 
The names are selected. 

Follow the instructions 
shown below the table 
before continuing on to 
the next step 

7. Select the Save and Close button. 
The group schedule dialog box closes, 
and the group calendar for the new 
group is saved. 

Click  Save and Close 

 
Use the Add Others button and the Add from Address Book command to add your 
partner and another person as indicated by your instructor. Select OK. 
 
Return to the table and continue on to the next step (step 7). 
 
Practice the Concept: You will use the group calendar you just created to schedule a 
meeting. Open the Group Schedules dialog box, select the Marketing  Dept group, if 
necessary, and then select Open. Use the Go to list to select next Friday. Scroll the 
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time interval box and select 2:00 pm (select another time, if everyone is not 
available). Select Make Meeting and select the New Meeting with All command to 
make a meeting with all the people in the group calendar. The Meeting window opens 
with the meeting addressed to all the group members. Close the Meeting window 
without saving the changes and cancel the group calendar dialog box. 
 
Delete the Marketing  Dept group calendar by selecting it in the Group Schedules 
dialog box, selecting Delete, and selecting Yes. Close the Group Schedules dialog 
box. 
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EXERCISE 

MANAGING MEETINGS 

�  Task 

Practice managing meetings. 
 
Note: To complete this exercise you will need to pair up with a fellow student to 
exchange meeting requests and messages. Substitute your initials for the <your 
initials> text in the meeting subjects. 

 
1. Open the Calendar, if necessary. 

2. Display the Day view for the current day. One partner should select 
the 9:00 to 10:00 am time slot and the other the 10:00 to 11:00 am 
time slot. Open the Meeting window (Hint:  Select the File menu, the 
New command and the Meeting Request command.) 

3. The subject of the meeting is New Catalog:<your initials> and the 
meeting location is My office. Use AutoDate to schedule the meeting 
for a date two weeks from today, instead of the currently displayed 
date. Use the Scheduling page to invite your partner. Send the 
meeting request. Make a note of the date and time. 

4. To schedule a second meeting, display the Calendar for a week from 
Friday and select the 1:00 to 3:00 pm time slot. Open the meeting 
planner. Schedule the Projector1 resource and invite your partner to 
the meeting. Make the meeting. 

5. The meeting is called the Managers Meeting:<your initials>. For 
the location, substitute Board Room for Projector1. Accept the 
other default settings, send the meeting request and close the meeting 
planner. Make a note of the date and time. 

6. Accept the invitation to the New Catalog:<your partner’s initials> 
meeting. 

7. Propose a different time for the Managers Meeting:<your partner’s 
initials>. One partner should pick the 8:00 AM to 10:00 AM time 
slot and the other the 10:00 AM to 12:00 PM time slot. 

8. When you receive a new time proposal from your partner, open the 
message and view all proposals. Select your partner’s proposal and 
send the update. 

9. When you receive an update for the new time proposal for your 
partner’s meeting, accept the new meeting time. 
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10. Check the meeting responses for the Manager Meeting:<your 
initials> meeting for which you are the organizer. (Hint:  Use the 
Tracking page.) 

11. Add another attendee to the Manager Meeting:<your initials> that 
you scheduled. and send updates to all attendees. 

12. Cancel the New Catalog meeting for which you are the organizer. 
Do not send a cancellation message. 

13. Create a group calendar called Executives and add your partner and 
another student as indicated by your instructor. 

14. View the attendee calendars. 

15. Delete the Executive calendar group. 

16. Delete any meetings on your Calendar without sending a response or 
cancellation notice. 

 



 

 

LESSON 3 -  
WORKING WITH TASKS  

In this lesson, you will learn how to: 

·  Open the Tasks folder  

·  Add a task  

·  Create a recurring task  

·  Edit a task  

·  Mark a task complete  

·  Sort tasks  

·  Assign a task to another Outlook user  

·  Accept/Decline tasks  

·  Indicate the progress of a task  

·  Send a status report  

·  View tasks assigned to others  

·  Print Tasks information  

·  Delete a task  
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OPENING THE TASKS FOLDER 

�  Discussion 

You can use the Tasks component of Outlook to manage your tasks. A task is a 
personal or work-related errand. Tasks can be recurring or happen only one time. For 
example, you can make an appointment a task that happens one time, and you can also 
create a recurring task to have your car washed every month. In addition to creating 
your own tasks, you can assign a task to another user by sending a task request. The 
recipient of the task request becomes the temporary owner. They can either accept or 
decline the task request. If they accept the task, they become the new owner of the 
task. If they decline the task request, it is returned to you. 
 
The owner of a task is the only person who can make changes to the task. When an 
owner makes changes to the task, Outlook updates the person who originally sent the 
task request. 
 
Tasks are saved in the Tasks folder, which you can access through the Tasks pane. 
You can open the Tasks pane from the Navigation Pane or the Go menu. Tasks work 
in conjunction with the TaskPad in the Calendar pane. You can manage and view 
tasks using either the TaskPad or the Tasks pane. The Tasks pane, however, offers 
more features and a larger viewing area than the TaskPad. 
 
Using the Tasks pane, you can prioritize tasks, track the progress of tasks, and 
perform other task management-related functions. Tasks that are late or overdue 
appear in the color red. 

 
The Tasks pane 
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�  
If your e-mail account is located on a Microsoft Exchange 
Server, you can use the Open Shared Tasks link in the 
Navigation Pane to open another person’s Tasks folder. You 
can only open another person’s folder if they have granted you 
permission. You can use the Share My Tasks link to share 
your Tasks folder with other users. These links are located 
below the Current View  pane. 

  

�  
The My Tasks pane displays your Tasks folder and any 
additional folders containing task items. While you can use the 
Folder List to open the Tasks folder, the My Tasks and 
Current View  panes do not appear when you use this method. 

  
 

�  Procedures 

1. Click the Tasks button on the Navigation Pane. 

 

�  Step-by-Step 

Open the Tasks pane to view the Tasks folder. 
 

Steps Practice Data 

1. Click the Tasks button on the 
Navigation Pane. 
The Tasks pane opens. 

Click  Tasks 

 

ADDING A TASK 

�  Discussion 

In the Tasks pane, you can add a task by typing it directly into the task list or by 
opening the Task window. When you add a task using the default view in the Tasks 
pane, you can specify the task Subject and Due Date in the Click here to add a new 
Task row. Opening a Task window offers additional options related to managing the 
task. You can enter the basic task information directly into the task list and then open 
the Task window to edit the task or add details and options as desired. 
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Adding a task 

 
  

�  
When entering due dates in the task list, AutoDate allows you 
to enter relative dates (such as next Thursday), which are 
automatically converted into date format by Outlook. You can 
also select a date from the popup calendar that appears when 
you click in a Due Date cell and then click the list arrow. 

  

�  
Although you can assign a due date to a task, you cannot 
assign a scheduled time. You can use the Calendar to enter 
activities that occur at a specific time. 

  

   �  
You can also open the Task window by double-clicking any 
blank cell in the task list. It may be necessary to expand the 
Task window in order to view all the information. 

  
 

�  Procedures 

1. Open the Tasks folder. 

2. Click the New Task button on the Standard toolbar. 

3. Type the subject of the task. 

4. Select the Due date box. 

5. Enter the due date for the task. 

6. Press [Enter] . 

7. Select the Save and Close button. 
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�  Step-by-Step 

Add a task. 
 
If necessary, open the Tasks pane. 

 

Steps Practice Data 

1. Click the New Task button on the 
Standard toolbar. 
The Task window opens with the 
insertion point in the Subject box. 

Click  New 

2. Type the subject of the task. 
The subject appears in the Subject 
box. 

Type Review monthly 
newsletter 

3. Select the Due date box. 
The text in the Due date box is 
selected. 

Press [Tab]  

4. Enter the due date for the task. 
The due date appears in the Due date 
box. 

Type next Friday 

5. Press [Enter] . 
The due date is entered and the 
InfoBar indicates when the task is due. 

Press [Enter]  

6. Select the Save and Close button. 
The Task window closes and the task is 
added to the task list. 

Click  Save and Close 

 
Practice the Concept: Add another task by clicking in the Click here to add a new 
Task row in the task list. Enter the subject Submit expense report. Select the Due 
Date column and the list arrow. Use the popup calendar to assign a due date two 
weeks from today. Press [Enter]  to add the task. 

CREATING A RECURRING TASK 

�  Discussion 

You can set tasks as recurring. Recurring tasks occur at the same time at regular 
intervals. For example, you may need to submit a weekly report every Friday. You 
can schedule that task as recurring so that it automatically appears in your task list 
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each month. Once you mark the recurring task complete for the current occurrence, 
the next occurrence appears. For example, if you have a weekly recurring task, once 
you complete the task for the current week and mark it complete, the same task 
appears in your task list with a due date for the following week. 
 
When you set an item as recurring, you must indicate a recurrence pattern. The pattern 
can be Daily, Weekly, Monthly , or Yearly. Depending on which option you choose, 
other recurrence options will be available. For example, if a task will be repeated 
weekly, you can indicate on which weeks and days the item should be scheduled. 
Additionally, you can specify a start date and the number of occurrences, or an end 
date. 

 
Creating a recurring task 

 
  

�  
You can also use the Recurrence button on the Standard 
toolbar in the Task window to open the Task Recurrence 
dialog box. 

  

�  
You can make an existing task recurring. Open the task, open 
the Task Recurrence dialog box and complete the recurrence 
settings. Save the task when you are done. 

  
 

�  Procedures 

1. Open the Tasks folder. 

2. Select the New Tasks button on the Standard toolbar. 

3. Type the subject of the task. 

4. Select the Actions menu. 
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5. Select the Recurrence command. 

6. Select a Daily, Weekly, Monthly , or Yearly recurrence pattern 
option. 

7. Select additional recurrence pattern options, as desired. 

8. Select other options under Range of recurrence, as desired. 

9. Select OK. 

10. Select the Save and Close button. 

 

�  Step-by-Step 

Create a recurring task. 
 
If necessary, open the Tasks pane. 
 
Use the New Tasks button to create a new task with the subject Submit monthly 
report to manager. 

 

Steps Practice Data 

1. Select the Actions menu. 
The Actions menu appears. 

Click Actions 

2. Select the Recurrence command. 
The Task Recurrence dialog box 
opens. 

Click Recurrence... 

3. Select a Daily, Weekly, Monthly , or 
Yearly recurrence pattern option. 
The desired option is selected. 

Click  Monthly  

4. Select additional recurrence pattern 
options, as desired. 
The desired options are selected. 

Follow the instructions 
shown below the table 
before continuing on to 
the next step  

5. Select other options under Range of 
recurrence, as desired. 
The desired options are selected. 

Click  No end date, if 
necessary 

6. Select OK. 
The Task Recurrence dialog box closes 
and the recurrence settings are saved. 

Click OK 
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Steps Practice Data 

7. Select the Save and Close button. 
The Task window closes and the 
recurring task is saved. 

Click  Save and Close 

 
In the right section under Recurrence pattern, use the list arrows in the middle 
option to select The last weekday of every 1 month(s). 
 
Return to the table and continue on to the next step (step 5). 
 
Notice the recurrence symbol in the Icon column to the left of the task in the task list. 

EDITING A TASK 

�  Discussion 

You can edit a task directly in the task list if the information you want to change 
appears in the view, or you can open the Task window. The Task page in the Task 
window allows you to add or edit information and set specific options for a task, 
including the subject and due date, task status and priority, and any reminders. The 
Details page allows you to enter and track the status of a project. When you edit a 
recurring task, all future occurrences are automatically updated. 
 

  

�  
You can edit a task subject or due date directly in the task list 
by clicking once on the task. You can then position the 
insertion point and edit the task as desired. 

  

�  
You may need to expand the Task window by dragging one of 
its borders or maximizing it to see its entire contents. 

  
 

�  Procedures 

1. Open the Tasks folder. 

2. Double-click the task you want to edit. 

3. Edit the task as desired. 

4. Select the Save and Close button. 
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�  Step-by-Step 

Edit a task. 
 
If necessary, open the Tasks pane. 

 

Steps Practice Data 

1. Double-click the task you want to edit. 
The task opens in a Task window. 

Double-click the Submit 
expense report task 

2. Edit the task as desired. 
The changes appear in the Task 
window. 

Follow the instructions 
shown below the table 
before continuing on to 
the next step  

3. Select the Save and Close button. 
The Task window closes and the 
changes to the task are saved. 

Click  Save and Close 

 
Select Low from the Priority list. 
 
Return to the table and continue on to the next step (step 3). 
 
Practice the Concept: Edit the Review monthly newsletter task by assigning it a 
status of In Progress. Save and close the task. 

MARKING A TASK COMPLETE 

�  Discussion 

As you finish tasks, you should mark them complete. Marking a task complete does 
not delete the task. When you mark a recurring task complete, the next occurrence of 
the task appears in the task list. A completed task appears with a line through it in the 
task list. If desired, you can remove the line to indicate that a task has not been 
completed. 
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Marking a task complete 

 
  

�  
Completed tasks appear in gray and overdue tasks in red. To 
change the colors, open the Options dialog box and select the 
Task Options button on the Preferences page. 

  
 

�  Procedures 

1. Open the Tasks folder. 

2. To mark a task complete, click the check box to the left of the task 
subject. 

3. To return the task to its original status of not complete, click the 
check box again to deselect it. 

 

�  Step-by-Step 

Mark a task complete. 
 
If necessary, open the Tasks pane. 
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Steps Practice Data 

1. To mark a task complete, click the 
check box to the left of the task 
subject. 
A check mark appears in the check box 
and the task subject is grayed and 
appears with a line through it. 

Click the check box to the 
left of the  Review 
monthly newsletter task 

2. To return the task to its original status 
of not complete, click the check box 
again to deselect it. 
The check mark is cleared from the 
check box, the line is removed from the 
subject, and the task subject text 
returns to black. 

Click the check box to the 
left of the  Review 
monthly newsletter task 

 
Deselect the task to view the results. 

 
Practice the Concept: Mark the Submit monthly report to manager recurring task 
complete. Notice that the next occurrence of the task appears in the task list. 

SORTING TASKS 

�  Discussion 

You can sort tasks quickly by clicking the column heading on which you want the sort 
to be based. For example, to sort by due date, you can click the Due Date column 
heading. You can sort a task by its column in ascending or descending order. Each 
time you click a column heading, you reverse its sort order. An arrow on the column 
heading indicates the direction of the sort. 
 

�  Procedures 

1. Open the Tasks folder. 

2. To sort tasks, click the column heading by which you want to sort. 

3. To change the order of the sort, click the same column heading a 
second time. 
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�  Step-by-Step 

Sort and reorder tasks. 
 
If necessary, open the Tasks pane. 

 

Steps Practice Data 

1. To sort tasks, click the column heading 
by which you want to sort. 
The tasks are sorted in ascending or 
descending order by the column 
heading and the arrow in the column 
heading points in the sort direction. 

Click the Due Date 
column heading 

2. To change the order of the sort, click 
the same column heading a second 
time. 
The tasks are sorted in the opposite 
order by the column heading and the 
arrow in the column heading points in 
the opposite direction. 

Click the Due Date 
column heading 

 
Practice the Concept: Sort the task list by Subject in ascending order (arrow 
pointing up). 

ASSIGNING A TASK TO ANOTHER OUTLOOK USER 

�  Discussion 

You can assign tasks by delegating them to other Outlook users. When a task is 
assigned to another user, it is sent as a message to the user’s Inbox. You can select 
options to track the status of the delegated task, as well as monitor the progress of the 
task. 
 
If the task recipient accepts the task, the task is added to the recipient’s task list and 
removed from yours unless you select the Keep an updated copy of this task on my 
task list option in the Task window. This option allows you to view the changes made 
to the task by the recipient in your task list. When the recipient records the task as 
completed, it will be marked complete in your task list. If you select the Send me a 
status report when this task is complete option, Outlook automatically delivers a 
message to your Inbox when the recipient indicates that the task is complete. 
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Assigning a task to another user 

 
  

�  
When you assign a task to another user, the task symbol in the 
task list changes to display a hand passing the task. 

  
 

  

�  
If you assign a task to more than one person at a time, Outlook 
cannot keep you updated on the progress of the task. 

  
 

�  Procedures 

1. Open the Tasks folder. 

2. Double-click the task you want to assign to another user. 

3. Maximize the Task window, if necessary. 

4. Select the Assign Task button. 

5. Enter the recipient’s e-mail address. 

6. Select options and settings as desired. 

7. Select the Send button. 
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8. Select OK if a Microsoft Outlook warning box opens, informing you 
that since you are no longer the owner of the task, you will not be 
sent a task reminder. 

 

�  Step-by-Step 

Assign a task to another Outlook user. 
 
Pair up with a fellow student so that you can exchange assigned tasks. 
 
If necessary, open the Tasks pane. 
 
Double-click the Review monthly newsletter task to open it in a Tasks window. 
Click at the end of the subject line and add a colon (:) and your initials. For example, 
Review monthly newsletter:tj. Maximize the Task window, if necessary. 

 

Steps Practice Data 

1. Select the Assign Task button. 
The options in the Task window 
change and the insertion point appears 
in the To box. 

Click  Assign Task 

2. Enter the recipient’s e-mail address. 
The text appears in the To box. 

Type the name of your 
partner, or another student 
as indicated by your 
instructor 

3. Select options and settings as desired. 
The options and settings are selected. 

Click  Keep an 
updated copy of this task 
on my task list, if 
necessary 

4. Continue selecting options and settings 
as desired. 
The options and settings appear in the 
Task window. 

Click  Send me a 
status report when this 
task is complete to 
deselect it 

5. Select the Send button. 
The Task window closes and the task is 
reassigned to another user. 

Click  Send 

 
Select OK if a Microsoft Outlook warning box opens, informing you that since you 
are no longer the owner of the task, you will not be sent a task reminder. 
 
Practice the Concept: Create a new task called Create meeting agenda:<your 
initials> with a due date of the next business day. Assign this task to the same student 
you assigned the Review monthly newsletter task. Keep an updated copy of the task, 
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but do not request a status report when the task is complete. Send the task and select 
OK when the Microsoft Outlook warning box opens. 

ACCEPTING/DECLINING TASKS 

�  Discussion 

When a task is assigned to you from another Outlook user, you receive a message 
with the subject Task Request in your Inbox asking you to accept or decline the task. 
You can accept or decline a task from the Reading Pane or Message window. 
Assigned tasks are automatically added to your task list when Outlook updates your 
tasks or after you read the task message. 
 
When you accept or decline a task, a Task Accepted or Task Declined message is 
sent to the owner of the task. You can include a response with this message or simply 
send the default message. Once you send your response to a task assignment, the Task 
Request message is removed from your Inbox. 
 
Furthermore, once you read a Task Accepted or Task Declined response message 
sent to you by the user to whom you assigned the task, it is removed from your Inbox. 
 
If you accept a task, the task remains in your task list. You can then update the owner 
on your progress as well as mark the task complete when you are finished. If you 
decline a task, the task is removed from your task list. Tasks you assign to others 
appear with a hand on the left side of the task icon and tasks assigned to you appear 
with hands on both sides of the task icon. 
 

�  Procedures 

1. Open the Inbox folder. 

2. Select or open the Task Request message. 

3. Select the Accept or Decline button. 

4. Select the Edit the response before sending or Send the response 
now option. 

5. Select OK. 

6. Type the desired response, if applicable. 

7. Select the Send button, if applicable. 
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�  Step-by-Step 

Accept/Decline tasks. 
 
Open the Inbox folder. Notice that two Task Request messages appear in your Inbox 
from another student. 

 

Steps Practice Data 

1. Select or open the Task Request 
message. 
The Task Request message opens in 
the Task window. 

Select the Task Request: 
Review monthly 
newsletter:<your 
partner’s initials> 
message 

2. Select the Accept or Decline button. 
The Accepting Task or Declining Task 
warning box opens. 

Click  Accept 

3. Select the Edit the response before 
sending or Send the response now 
option. 
The desired option is selected. 

Click  Send the 
response now option, if 
necessary 

4. Select OK. 
The Accepting Task or Declining Task 
warning box closes and the response is 
sent. 

Click OK 

 
Notice that the Task Request: Review monthly newsletter:<your partner’s initials> 
message no longer appears in your Inbox. 
 
Practice the Concept: Decline the Task Request for the Create meeting agenda 
task. Send the response now, without editing it. Notice that the message no longer 
appears in your Inbox. 
 
Open the Tasks pane and notice that you now have a new Review monthly 
newsletter:<your partner’s initials> task in the task list. This is the task you accepted 
from your partner. Also notice that only one Create meeting agenda task, the one 
you assigned to another user, appears in the task list. The one assigned to you no 
longer appears in the task list since you declined it. The tasks you created and 
assigned to another student appear with a hand on the left side of the task icon. The 
task assigned to you, which you accepted, appears with hands on both sides of the task 
icon. 
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INDICATING THE PROGRESS OF A TASK 

�  Discussion 

If a task is assigned to you, you can accept or decline it, or you can assign it to 
someone else. If you accept the task, you can indicate your progress as you work on 
the task. This option helps you manage your overall workload. In addition, it allows 
other Outlook users to maintain task lists that include your tasks so that they can track 
your progress. 
 
You indicate your progress on a task by entering a percentage complete on the Task 
page in the Task window. You can further indicate your progress on the Details page 
in the Task window, where you can indicate the Total work (an estimation of the 
number of hours to complete the project) and the Actual work  (the number of hours 
you have spent on the project). 
 
If the task owner selected the option to keep an updated copy in his or her task list, a 
Task Update message will be sent each time the task recipient changes the task 
details. 

 
Entering the progress of a task 

 
  

�  
When a task is reassigned, the owner’s task details update only 
when the owner opens the Task Update message in the Inbox. 
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�  Procedures 

1. Open the Tasks folder. 

2. Double-click the task for which you want to track the progress. 

3. Enter the percent complete in the % Complete spin box. 

4. Select the Details tab. 

5. Select the text in the Total work  box. 

6. Type the estimated time or days it will take to complete the task. 

7. Select the text in the Actual work  box. 

8. Type the amount of time you spent on the task to date. 

9. Select the Save and Close button. 

 

�  Step-by-Step 

Indicate the progress of a task. 
 
If necessary, accept the Review monthly newsletter:<your partner’s initials> task 
assigned to you by another student and open the Tasks folder. 

 

Steps Practice Data 

1. Double-click the task for which you 
want to track the progress. 
The task opens in a Task window. 

Double-click the Review 
monthly 
newsletter:<your 
partner’s initials> task 
(hands on both sides of the 
task icon) 

2. Enter the percent complete in the % 
Complete spin box. 
The percent complete appears in the % 
Complete spin box. 

Click % Complete  as 
necessary to 25% 

3. Select the Details tab. 
The Details page appears with the text 
in the Date completed box selected. 

Click the Details tab 

4. Select the text in the Total work  box. 
The text in the Total work box is 
selected. 

Press [Tab] 
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Steps Practice Data 

5. Type the estimated time or days it will 
take to complete the task. 
The estimated time appears in the 
Total work box. 

Type 10 hrs 

6. Select the text in the Actual work  
box. 
The text in the Actual work box is 
selected. 

Press [Tab] 

7. Type the amount of time you spent on 
the task to date. 
The amount of time spent appears in 
the Actual work box. 

Type 2.5 hrs 

8. Select the Save and Close button. 
The Task window closes and the 
progress of the task is saved. 

Click  Save and Close 

 
Check your Inbox and open the Task Update item from another student. View the 
Details page and then close the Task window. When you close the Task window, the 
Task Update item is removed from your Inbox folder and the original task in the 
Tasks folder is updated. 

SENDING A STATUS REPORT 

�  Discussion 

You can send information about the status of a task to others. When you send a status 
report, a message is sent summarizing the work progress of the task. The summary 
details include the task name, priority, date due, its current status, the percentage of 
work completed, the total and actual work, and the name of the task owner. 
 
When a task is assigned to another owner, the person assigning the task is added to an 
update list if they selected the option to keep an updated copy of the task in their task 
list. Each person reassigning the task is then added to the list. When the task owner 
sends a status report, it is sent to everyone on the update list. 
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Sending a status report 

 

�  Procedures 

1. Open the Tasks folder. 

2. Double-click the task about which you want to send a status report. 

3. Select the Actions menu. 

4. Select the Send Status Report command. 

5. Maximize the Message window, if necessary. 

6. Enter the name or address of the recipient in the To box, if 
necessary. 

7. Select the Send button. 

 

�  Step-by-Step 

Send a status report about a task to another user. 
 
If necessary, indicate your progress on the Review monthly newsletter:<your 
partner’s initials> task assigned to you by another student. 
 
Open the Tasks folder. 
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Steps Practice Data 

1. Double-click the task about which you 
want to send a status report. 
The task opens in a Task window. 

Double-click the Review 
monthly 
newsletter:<your 
partner’s initials> task 
(hands on both sides of the 
task icon) 

2. Select the Actions menu. 
The Actions menu appears. 

Click Actions 

3. Select the Send Status Report 
command. 
A Message window opens with the 
status report displayed and the task 
owner’s name appears in the To box if 
he or she has chosen to track the task. 

Click Send Status Report 

4. Maximize the Message window, if 
necessary. 
The Message window is maximized. 

Click  on the Message 
window title bar, if 
necessary 

5. Enter the name or address of the 
recipient in the To box, if necessary. 
The name or address of the recipient 
appear in the To box. 

Follow the instructions 
shown below the table 
before continuing on to 
the next step 

6. Select the Send button. 
The message is delivered to the 
appropriate recipients. 

Click  Send 

 
The name of the person who assigned the task should appear in the To box. If not, 
enter your partner’s or another student’s name as indicated by your instructor. 
 
Return to the table and continue on to the next step (step 6). 
 
Close the Task window. Open your Inbox folder and then open the Task Status 
Report:<your partner’s initials> message from another user. When you have 
finished viewing the status report, close the Message window, and then open the 
Tasks pane. 

VIEWING TASKS ASSIGNED TO OTHERS 

�  Discussion 

You should keep track of tasks assigned that you have assigned to other users. To help 
you do this, you can filter your tasks to view only those tasks that you have assigned 
to others. 
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In addition to viewing the tasks you have assigned to others, you can use the view that 
best suits the task at hand. The default view in the Tasks pane is the Simple List 
view, which displays the subject and due date for each task. However, you can select 
other views that display more details, or filter the tasks according to a specific 
property from the Current View  pane in the Navigation Pane. 
 

  

�  
You can also enable AutoPreview and the Reading Pane from 
the View menu to view more task details. 

  
 

�  Procedures 

1. Open the Tasks folder. 

2. Select the Assignment option from the Current View  pane. 

 

�  Step-by-Step 

View tasks assigned to others. 
 
If necessary, open the Tasks pane. 

 

Steps Practice Data 

1. Select the Assignment option from the 
Current View  pane. 
The Assignment view appears. 

Click  Assignment 

 
Practice the Concept: Return the view to Simple List, which is the default. 

PRINTING TASKS INFORMATION 

�  Discussion 

You can print Tasks information and individual task items in a number of different 
ways. You can use the Print dialog box to print the entire task list or just the selected 
task. 
 
Outlook provides two predefined print styles in the Print dialog box: Table Style and 
Memo Style. Table Style, the default style for printing tasks, prints the entire task 
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list. Memo Style, which is only available when a task is selected, prints the selected 
tasks in a memo format. 
 
The Print dialog box offers control over the way your printed output will appear. You 
can control the printer to be used, the style used in printing, and a number of other 
variables. You can also define the number of pages and copies you want to print. 
 

  

�  
To quickly print the details of an individual task, right-click 
the item and select the Print  command. 

  

�  
You can select and print multiple task items using the [Ctrl]  
and [Shift]  keys. You can select all items by selecting the Edit 
menu and then the Select All command. 

  
 

�  Procedures 

1. Open the Tasks folder. 

2. Select the tasks you want to print, if applicable. 

3. Select the File menu. 

4. Select the Print  command. 

5. Select print options as desired. 

6. Select OK. 

 

�  Step-by-Step 

Print Tasks information. 
 
If necessary, open the Tasks pane. 

 

Steps Practice Data 

1.  Select the File menu. 
The File menu appears. 

Click File 

2. Select the Print  command. 
The Print dialog box opens. 

Click Print…  

3. Select print options as desired. 
The desired print options are selected. 

Click Table Style, if 
necessary 
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Steps Practice Data 

4. Select OK. 
The Print dialog box closes, a Printing 
message box opens to inform you of 
the print status, Outlook prints the 
Tasks information according to the 
options selected, and the message box 
closes. 

Click OK 

 

DELETING A TASK 

�  Discussion 

You should delete tasks you no longer want to appear in your task list. One-time tasks 
disappear from your task list immediately when you delete them. When you attempt to 
delete a recurring task, you are given the option of deleting the current occurrence or 
all occurrences. When you attempt to delete a task assigned to you by another user 
that is incomplete, you are prompted to confirm the deletion and send a notice to the 
task owner. 
 
In addition to using the Delete button on the Standard toolbar, you can delete tasks 
using the Delete command on the shortcut or Edit  menu, or by pressing the [Delete] 
key. However, deleted tasks can be restored from the Deleted Items folder since they 
are not actually removed from your computer until the Deleted Items folder is 
emptied. 
 

�  Procedures 

1. Open the Tasks folder. 

2. Select the task you want to delete. 

3. Click the Delete button  on the Standard toolbar. 

4. Select the appropriate option for handling recurring or incomplete 
tasks, as well as tasks assigned to you by another user, if applicable. 

5. Select OK, if applicable. 
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�  Step-by-Step 

Delete a task. 
 
If necessary, open the Tasks pane. 

 

Steps Practice Data 

1. Select the task you want to delete. 
The task is selected. 

Click the Submit expense 
report  task 

2. Click the Delete button on the 
Standard toolbar. 
The task is deleted. 

Click  

 
Practice the Concept: Delete the remaining tasks. If the Delete Incomplete Task 
warning box opens, select the Delete option, and then select OK. If the Microsoft 
Outlook warning box opens for a recurring task, select the Delete all option, if 
necessary, and then select OK. 
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EXERCISE 

WORKING WITH TASKS 

�  Task 

Practice working with tasks. 
 

1. Open the Tasks pane, if necessary. 

2. Add three new tasks. Create the first task with the subject Review 
training materials and a due date of next Wednesday. Create a 
second task with the subject Prepare training rooms and systems 
and a due date of next Thursday, and the third task with the subject 
Conduct intermediate training and a due date of next Friday. 

3. Create a recurring task with the subject Prepare training report  that 
occurs monthly on the first weekday of the month. Save the task. 

4. Sort the tasks by subject in descending order. Then, sort the tasks by 
due date in ascending order.  

5. Assign a High priority level to the Conduct intermediate training 
task. 

6. Assign the Conduct intermediate training task to another student 
as indicated by your instructor. 

7. When you receive a Task Request message from another student, 
accept the task and send the response now. 

8. Indicate that the Prepare training rooms and systems task is 50% 
complete. 

9. Send a status report about the Prepare training rooms and systems 
task to another student as indicated by your instructor. Close the 
Task window. 

10. When you receive a Task Status Report message from another 
student, open the message and view the status report. 

11. Mark the Review training materials task complete. 

12. Print the Prepare training rooms and systems task in Memo Style. 

13. Change the view to Task Timeline. Scroll as necessary to view the 
tasks. Change the view back to Simple List. 

14. Delete the tasks you created during this exercise, including all 
occurrences of the recurring task. 
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Appointments 

automatically coloring, 22 
coloring, 20 
editing label colors, 20, 21 
scheduling new, 6, 8, 9 

AutoDate 
using, 7 

Calendar 
adding a task to the TaskPad, 14, 16 
automatically coloring items, 22, 23, 24 
canceling meetings, 54 
coloring items, 20 
create group calendars, 55, 56, 57 
deleting items, 33 
editing items, 17 
editing label colors, 20, 21 
moving items, 27, 28 
navigating, 3, 4, 5 
opening, 2, 3 
printing Calendar information, 31, 32 
proposing a new meeting time, 47 
responding to a meeting, 45, 46 
responding to a new time proposal, 48, 49 
scheduling a resource for a meeting, 42, 43 
scheduling events, 11, 12, 13 
scheduling meetings, 38, 39, 40 
scheduling new appointments, 6, 8, 9 
setting items as recurring, 25, 26 
tracking meeting responses, 50, 51 
updating meetings, 52 
using AutoDate, 7 
using views, 18, 19 

Calendar pane 
using, 2, 3 
viewing side by side calendars, 29, 30 

Events 
scheduling, 11, 12, 13 

Folders 
Calendar, 2 
Tasks, 62 

Meetings 
canceling, 54 
planning, 38 
proposing a new time, 47 
responding to, 45, 46 
responding to a new time proposal, 48, 49 
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scheduling, 38, 39, 40 
scheduling a resource, 38, 42, 43 
tracking responses, 50, 51 
updating, 52 

Plan a Meeting 
using, 38 

TaskPad 
displaying, 14, 16 

Tasks 
accepting, 75, 76 
adding, 63, 64, 65 
adding to the TaskPad, 14, 16 
assigning to other Outlook users, 72, 73, 74 
creating recurring, 65, 66, 67 
declining, 75, 76 
deleting, 84, 85 
editing, 68, 69 
indicating progress, 77, 78 
marking as complete, 69, 70 
opening the folder, 62, 63 
printing Tasks information, 82, 83 
sending a status report, 79, 80 
sorting, 71, 72 
viewing those assigned to others, 81, 82 

Tasks pane 
using, 62, 63 

 


